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Fontlarimiza Tiirk¢e Ogretelim

Unicode [Evrensel Kod] Nedir?

Evrensel Kod her yazi karakteri i¢in bir ve yalniz bir
say1 sart kosar, hangi altyapi, hangi yazilim, hangi
dil olursa olsun.

ilke olarak, bilgisayarlar sadece sayilarla islem ya-
parlar. Kelimelerin ve yazi karakterlerinin her biri
i¢in birer say1 atarlar ve béyle saklarlar. Evrensel
Kod kesfedilmeden 6nce, bu sayilari atamak igin
birgok sifreleme yontemi vardi. Ancak, tim bu
dilleri gosterebilecek, 6rnegin; Avrupa Toplulugu
biinyesindeki tiim tilkelerin dillerini kapsayacak bir
tek sifreleme yontemi yoktu. Bunun yanisira, sadece
Ingilizcedeki harfleri, noktalama isaretlerini ve tek-
nik sembolleri kapsayan tek bir sifreleme yontemi
de bulunmamaktaydi.

Bu sifreleme yontemleri kendi aralarinda gelismek-
tedir. Iki farkli sifreleme, ayn1 say1y1 iki farkli karak-
tere vermis olabilir ya da farkli sayilar ayni karekteri
kodlayabilir. Bilgisayarlar, 6zellikle sunucular, bir-
ok sifrelemeyi desteklemek zorundadirlar; veriler,
farkli sifreleme ve altyapilardan gegerken bozulma
riski tagirlar.

Evrensel Kod biitiin bunlar1 degistiriyor!

Evrensel Kod her yazi karakteri i¢in altyapi, yazilim
ve dil gozetmeksizin bir ve yalniz bir say1 sart kogar.
Apple, HP, IBM, JustSystem, Microsoft, Oracle, SAP,
Sun, Sybase, Unisys ve endiistrinin diger ileri gelen
firmalar1 Evrensel Kod Standardini desteklemekte-
dirler. Evrensel Kod, XML, Java, ECMAScript [Ja-
vaScript], LDAP, CORBA 3.0, WML vb. gibi modern

standartlar tarafindan ISO/IEC 10646 uyarlanma-
sinin resmi yoludur. Birgok isletim sistemi, modern
web gezgini ve diger tiriinler Evrensel Kod'u des-
teklemektedir. Evrensel Kod standardininin kulla-
nilmasi ve onu destekleyen yazilimlarin bulunmasi
son zamanlardaki kiiresel yazilim teknolojilerinin
en popiiler konusudur.

Evrensel Kod’un, istemci-sunucu ya da gok katman-
11 uygulamalar ve web sitelerinde kullanimi 6nemli
bir diizeyde tasarruf saglamaktadir. Evrensel Kod
tek bir yazilimin ya da bir web sitesinin yeniden
tasarlanmasina ihtiya¢ duyulmadan her tiirlii dil ve
tilke i¢in uyumlu hale getirilmesini saglar. Ayni za-
manda verinin gesitli isletim sistemleri igerisinden
aktarimini da sorunsuz hale getirmektedir.
Kaynak: http://www.unicode.org/standard/transla-
tions/turkish.html

Type 1 font nedir?
PostScript  bilgisayar dili
Adobe tarafindan gelistiril-
mis bir dildir. Baslangigta
dokiimanlar1  goriintiile-
me ve yazdirma ile ilgili olan PostScript, zamanla
bir ¢ok degisiklik gosterdi. Dil, metin ve grafikleri
birlestirerek her harfi genel bir grafik objesi olarak
gosterir hale geldi. Bu karakterler yazicilarda daha
yogun kullanildik¢a PostScript dili, harfleri ve ge-
killeri diizenleyen bir operatoér olarak galigmaya
basladi. Bu grafik koleksiyonlar font olarak adlan-
dirildilar.



Type 1 olarak adlandirilan bu fontlarin her biri
harfler ve sembollerden olusur ve kendilerine has
ozelliklere sahiptir. Ekran ve yazici fontu olmak
tizere iki pargadan olusurlar. Ekran fontlari, uygu-
lamalarda diizgiin goriintiilenmesini, yazici fontlar
da baski alinabilmesini saglar.

True Type Nedir?
\ - .TI‘ TrueType, Apple tarafindan dijital
> olarak tasarlanmis ve hem Apple

e Symbol pery de Windows tabanli bilgi-

et sayarlarda kullanilan dijital yaz1
karakterleridir. TrueType fontlar, bilgisayarinizin
ekraninda ve yazicilarinizda en yiiksek kaliteyi al-
manizi saglar.

. OpenType Nedir?

OpenType Microsoft ve Adobe
tarafindan beraberce gelistirilen
yeni bir ¢apraz platform font tii-
riddiir. Adobe, Adobe Type Font
kitiiphanesindeki, 2200’den fazla fontu OpenType
formatina ¢evirmigtir.
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OpenType formatinin iki ana faydasi varduir:

1] Ayni fontu hem Macintosh hem de Windows ta-
banli bilgisayarlarda kullanabilmeyi saglayan Cap-
raz Platform Uyumlulugu.

2] Genisletilmis karakter grubu ve mizanpajlar1
desteklemesiyle ¢ok daha genis dil destegi ve gelis-
mis tipografik kontroller sunmasi.

Ayrica OpenType formati, TrueType SENT formati-
nin gelistirilmis sekli oldugundan Adobe PostScript
font datasina ve yeni tipografik 6zelliklere sahiptir.

Adobe tarafindan yayinlanan Tiirkge karakterlere
sahip OpenType fontlar Pro uzantili fontlardir [6rn:
Myriad Pro.otf ]. OpenType fontlari, Post Script 1 ve
True Type yerine yiiklenerek kullanilabilir.

Fontlarimiz1 diledigimiz gibi paylasabilir
miyiz?

Duruma gore degisir. Yazilimlarda oldugu gibi font-
larin da ticretsiz olanlar1 mevcuttur fakat genellik-
le bilgisayarlarda kullanilan kaliteli fontlar ticrete
tabidir. Ucretsiz olarak dagitilan fontlar genellikle
[her zaman degil] tipografik hatalarla doludur. Her-
kesin bilip kullandig1 kendini ispatlamis fontlar
ise gogunlukla ticretlidir. Fontlarinizi paylagirken
lisansli olup olmadiklarina dikkat edin. Lisansl ve
edinilmesi ticrete tabi fontlarinizi paylagsmamaniz
gerekir!

Nereden font satinalabilirim?

Bir ¢ok font iireticisi mevcuttur. Bunlarin en bilin-
dik olanlari:

Adobe [http://studio.adobe.com/us/type/main.jsp]
Emigre [http://www.emigre.com/]

ITC [http://www.itcfonts.com/]

House Industries [http://www.houseind.com/]
Agfa Monotype [http://www.fonts.com]

Linotype [http://www.linotype.com/]

The Font Bureau [http://www.fontbureau.com/]
Font Font [http://www.fontfont.com/],

URW++ [http://www.urwpp.de/],

FontFabrik [http://www.fontfabrik.com/]’dir.
[Daha fazlasi igin: http://www.fonts.com/Find-
Fonts/Foundries.htm]

Internet iizerinden bu fontlar1 alabileceginiz gibi en
genis font arsivine sahip Adobe fontlarini Tiirkiye
temsilcisi Bilkom’dan [www.bilkom.com.tr/adobe]
da temin edebilirsiniz.

Bu fontun ad1 ne?

Ekranda ismini bilmediginiz bir font ile ytizlesti-
ginizde, elinizdeki tiim fontlara goz atarak eglestir-
meye ¢alismak keyif verici bir durum degil. Bu isi
sizin i¢in yapan ve ¢ogu zaman tam isabet tutturan
bir site mevcut.

Oncelikle, www.myfonts.com/WhatTheFont say-
fasin1 bookmark listenizin en miistesna kosesine
kaydedin. Ekrandaki fonttan 6-7 farkli karakterlik
temiz bir ekran goriintiisii gekip jpeg formatinda
kaydedin. Sayfanin hemen tizerindeki “Local File
> Choose File” butonuna basarak, kaydettiginiz
dosyay: tanimlayin ve “Upload Image” butonuna
basarak siteye yiikleyin.

Islem tamamlandiktan sonra, yiiklenen dosyada
goriintiilenen harfleri alttaki “Character Selection”
boliimiinden teyit edin ve “Search” butonuna tik-
layin. Bu islem sonrasinda, karakterlere [glyph] en
yakin fontlar listelenecektir. Yiiklediginiz font ile
eslesen fontu listeden bulun.

Fontlarimiz nerede durmali? [Mac]

Eger Mac OS X {izerinde bir font yénetim progra-
mi1 kullanmiyorsaniz, fontlarinizin nerede duracagi
konusunda bilingli bir se¢im yapmaniz gerekiyor.
Mac OS X’in ¢oklu kullanici yapis1 geregi, sistem
dizininde yer alan 3 ayri Library [kiitiiphane] ve
Fonts [Fontlar] klasérii kafanizi karigstirmasin.
System>Library>Fonts dizini, sistem genelinde kul-
lanilan fontlara ev sahipligi yaptigindan, midahale
etmemeniz gereken bir dizindir.



HD > Library > Fonts dizini igerisinde yer alan font-
lar ise, sistem tizerindeki tiim kullanici hesaplarin-
da aktif olacagindan, sistem fontlarinin bu dizinde
yer almasi isabetli bir secimdir.

Sistem bilesenleri tarafindan kullanilmayan ve gra-
fik fontu ozelligine sahip fontlarimizi da bu dizin-
de tutmanin teorik olarak hi¢bir mahsuru yoktur.
Ancak sistem fontlar: ile grafik fontlarinin birarada
bulunmasi, font sayis: arttiginda karmasa yaratabi-
lir. Karmagay1 6nlemenin en kolay yontemi, grafik
fontlarini bir klasérde toplamaniz ve bu dizine kla-
sor halinde eklemenizdir. Hatta kategorilerine gore
ayirdiginiz fontlar: farkli klasorlere yerlestirip bu
dizin icerisinde tutabilirsiniz.

- Kategorize etmek, klasorlemek vs. uzun is. Sistem
fontlarini renklendirip etiketlendirirsem, diger font-
lardan ayrilir ve karmasa olmaz degil mi?

- Fena fikir degil, ancak kategorize edilmemis grafik
fontlarinin bir kismint devre disi birakma ani geldi-
ginde, keske diger yontemi uygulasaydim diyebilirsi-
niz.

Herkesin fontu kendine [Mac]

Sistem iizerinde birden fazla kullanici farkli font
setlerine sahipse, bu fontlarin HD>Library>Fonts
dizininde yer almasi, kullanicilar ve g¢alistiklar:
isler baglaminda kesinlikle kargasaya sebep olur.
Ciinki bu dizinde yer alan fontlar, sistemdeki tiim
kullanicilar i¢in devreye giriyordu hatirlarsaniz. O
halde, eger sahiplendiginiz ve/veya sadece sizin he-
sabinizda aktif olmasini istediginiz fontlar varsa, bu
fontlar1 HD>Users>User>Library>Fonts dizininde
tutmaniz yeterlidir.

Bu dizinle ilgili birkag noktanin da altini gizelim.
Eger bu dizinde, internet ve sistem yazilimlari
[Mail, Safari, AddressBook, iPhoto, iTunes vb.] kul-
lanilan sistem fontu tutarsaniz, sistem 6ncelikle
User>Library>Fonts dizinini dikkate alacagindan,
HD>Library>Fonts dizininde bulunan fontlar dev-
reye girmez. Eger Tiirkce karakterlerin dahil olma-
dig1 sistem fontlar1 bu dizine bir sekilde yerlesirse,
ana kiitiiphanedeki diizgiin sistem fontlar1 devreye
girmeyeceginden, Tiirkge karakterlerin goriinti-
lenmesinde problem ¢ikacaktir.

Fontlarinizin bulunabilecegi bir baska bolim ise
Applications [Uygulamalar] klasérii iginde bulunan
programlarin kendi font klasoriidiir. Buradaki font-
lar gériintillenme agsamasinda en 6n siradadirlar.
Sistem bir font aradiginda en 6nce bu boliime baka-
caktir. Ozellikle, Microsoft yazilimlarinin yiiklen-
mesi sirasinda kargimiza ¢ikan bu durum Tirkge

karakterlere sahip olmayan fontlarin 6ne ¢ikmasina
ve uygulamalarda Tiirkge karakter problemi yagan-
masina sebep olmaktadir. Bu fontlari, endiselenme-
den ¢6p sepetine gonderebilirsiniz. [HD>Applicatio
ns>Microsoft Office 2004>Office>Fonts]

Bir baska font saklanan alan da HD>Library> App-
lication Support>...>Fonts. Aman dikkat!!! Bu bo-
limde bulunan fontlar1 silmeyin. Eger silerseniz
ilgili uygulama agilmaya bilir.

Fontlarimiz nerede durmali? [PC]

Windows  isletim  sisteminde  fontlariniz
C>Windows>Fonts klasorii altinda durmalidir.
Fontlarinizi buraya siiriikleyip birakmak yerine bu
klasordeyken File meniisiinden “Install New Font”
komutu vererek agilan pencereden fontlarinizi yiik-
lemeniz daha saglikli bir yéntemdir.

Fontlarin bulundugu bir diger béliim de Program
Files>Profram>Fonts klasoriidiir. Buradaki fontlar
genellikle uygulamalarin kullandigi fontlar olup
dokunulmamasinda fayda vardir.
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Windows kullanicilarinin da fontlar klasériine
fontlarini yiiklemek yerine font yoneticisi kullan-
malarini oneririz.

Font yoneticisi nedir?

Font yoneticileri, fontlar1 sisteme yiiklemeye ge-
rek birakmadan agip kapatmaya yarayan islevsel
uygulamalardir. Aslinda bir fontu kullanmak igin
herhangi bir font yoneticisi kullanmak zorunda de-
gilsiniz. Bilgisayarlarinizin igletim sistemine gore
fontlarinizi uygun yere koymaniz kullanmaniz igin
yeterlidir. Fakat bunun bazi sakincalar: vardir. Bel-
li sayidan fazla fontu isletim sistemi igerisinde her
an aktif olarak barindirmak bilgisayarinizin hizina



dogrudan etki etmektedir. Font say1s1 arttikga bilgi-
sayarinizin ¢alisma hizi yavaslayacaktir.

Bir diger konu hasarli fontlardir. Isletim sistemi
igerisinde bulunan hasarli fontlar uygulamalarin
beklenmedik sekilde kesintiye ugramasinin baslica
sebeplerindendir.

Font yoneticileri, fontlarinizi hizlica aktif/deaktif
edebilmenizin yaninda, hasarli fontlar1 tespit edip
askiya alabilir. ID numaralar1 ¢akigan fontlar: tes-
pit edip, devre dis1 birakmanizi saglar. Otomatik
aktivasyon ozelligi sayesinde, daha énce herhangi
bir dokiimanda kullanilan deaktif fontlar, ilgili do-
kiimanin agilmasi ile birlikte otomatik olarak aktif
edebilir.

Kitiiphanesinde tanimli fontlarin karakteristik
ozelliklerini alternatifli secenekler dahilinde gore-
bilmenizi saglar.

Kullanicilarin islerini olduk¢a kolaylagtiran bu
avantajlarinin disinda, daha birgok ozelliklerden
faydalanmak i¢in bir font y6neticisi kullanmak en
saglikli yoldur.

Peki hangi font yoneticisini kullanmalryim?
Fontlar kadar olmasa da bir ¢ok font y6neticisi bu-
lunmaktadir. Font yoneticilerinin isleyisi ve hatta
sahip olduklar grafik arayiiz temelde ayni olmakla
birlikte, sistem uyumlulugu, hiz ve pratik kullanim
bakimindan farkli olabilirler. Font yéneticilerine
gegmeden Once, konu ile ilgili temel komutlara goz
atalim:

Font Yiikleme: Mevcut fontlarinizin font yonetici-
sine aktarilma iglemidir kisaca. Boylelikle ne kadar
fontunuz oldugunu bilecek olan font y6neticisi, font-
lar1 heniiz yiikleme aninda test edip, hatali olanlar
hakkinda rapor verebilecektir. Add Font [Font ekle],
Import komutu veya Drag&Drop [siiriikle-birak]
yontemini kullanarak, fontlarimizi yiikleyebilirsi-
niz. Fontlarin font yoneticisine yiiklenmis olmasi,
aktif olduklar1 anlamina gelmez. Ancak eger ister-
seniz, yiiklemeyle birlikte aktif olmasini saglayacak
komut da mevcuttur.

Aktivasyon: Font Yoneticisi kiitiiphanesinde tanimli
fontlarin, tek tek veya font setleri halinde devreye
sokulmasi iglemidir. Aktif edilen font setleri es za-
manli olarak font meniilerinde aktif hale gelir.

Deaktivasyon: Aktif olan herhangi bir fontun tek
tek veya font setleri halinde devre dig1 birakilmasi
islemidir.

Auto-Activation: Daha 6nce aktif olan ve bir dokii-
manda kullanilan font setlerinin, ilgili dokiimanin
tekrar agilmasi ile birlikte Font Yoneticisi tarafin-
dan otomatik olarak aktif hale getirilmesi iglemidir.
Bu 6zelligin devreye girmesi, ¢alistiginiz dokiiman-
lara ait programlara entegre edilen otomatik akti-
vasyon plug-in’leri aracilig1 ile gergeklestirilir.

Preview: Sectiginiz herhangi bir fontun tiim karak-
teristik 6zelliklerinin sergilenmesidir.

WYSIWYG [What You See Is What You Get / Ne
goriirsen onu alirsin]: Bu enteresan tanimlamanin
tasidig1 anlam, fontlarin kendi karakteristik 6zel-
likleriyle listelenmesidir.

FontBook: Mac OS X isletim sistemi ile birlikte
gelen tcretsiz font yoneticisi. iTunes mantigiy-
la ¢alisan FontBook, kendisine tanmitilan fontlari,
User>Library>Fonts klasoriine tagiyarak hem sis-
teme yiik bindirdiginden hem de font agma ve ka-
pama islemini agirdan almasi sebebiyle pek tercih
edilmemektedir.

Fontlarinizi FontBook iizerinden devreye sokmak
i¢in, ilgili fontu programin Fontlar listesi tizeri-
ne siiriikleyip birakmaniz veya font dosyasina gift
tiklayip, ¢ikan pencereden Install Font komutunu
vermeniz yeterlidir.

Collection siitunundan, sistem ve kullanicilara ait
font setleri goriintiilenmektir. Bu siitunun altinda-
ki [+] butonuna basarak kendi font setlerinizi olug-
turabilirsiniz.

Edit meniisiinde goreceginiz Disable [Pasif] ve
Enable [Aktif] komutlarini kullanarak, fontlarinizi
devreye sokabilir veya devre dis1 birakabilirsiniz.
[Sadece Mac siiriimii bulunmaktadir.]

Suitcase Fusion: Extensis [http://www.extensis.
com/] tarafindan iiretilen ve yaygin olarak kul-
lanilan tcretli font yoneticisi. Bilinen en eski font
yoneticilerinden olan Suitcase’in son siiriimii olan
Fusion, sorunsuz bir sekilde ¢aligmasina karsin
fontlarin aktif kalabilmesi i¢in programin da agik
tutulmasi gerekliliginden vazgegememistir.

[Son versiyonunun sadece Mac siiriimii bulunmak-
tadir.]

Font Reserve: Extensis [http://www.extensis.com/]
tarafindan tiretilen font yoneticisi. Suitcase Fusion’a
benzeyen oldukga kullanisl bir uygulama.
[Sadece Windows siiriimii bulunmaktadir.]



FontAgentPro: Insider Software [http://www.insi-
dersoftware.com/] tarafindan iiretilen {icretli font
yoneticisi. Bir ¢ok yonden bagarili olan program,
Suitcase’e alternatif giiclii bir font yoneticisidir.

Suitcase’e agina olan kullanicilarin kullanmakta zor-
lanmayacaklar1 FontAgentPro, otomatik aktivasyon
[auto activation], coklu kiitiiphane [multiple librari-
es], WYSIWYG, problemli ve miikerrer fontlar: tes-
pit edebilme gibi tercih sebebi olabilecek ozelliklere
sahiptir. Suitcase’in aksine, FontAgentPronun font
yonetimi sirasinda agik kalmasi gerekmemektedir.
[Sadece Mac siiriimii bulunmaktadir.]

Font Explorer: Linotype [http://www.linotype.
com/fontexplorerX] tarafindan tretilen tcretsiz
font yoneticisi. Tamamen iTunes mantig1 ve arayii-
ziine sahip olup kolay kullanimi ve ticretsiz olma-
styla y1ldizi1 bir anda parlayan bir uygulama.
[Sadece Mac siiriimii bulunmaktadir.]

Font xplorer: Moon Software [http://www.moon-
software.com/fxplorer.asp] tarafindan gelistirilmis
bir font yoneticisidir.

[Sadece Windows siiriimii bulunmaktadir.]

Font Fitting Room: ApoliSoft [http://www.apoli-
soft.com/] tarafindan gelistirilmis oldukga yetenek-
li bir font yoneticisidir.

[Sadece Windows siiriimii bulunmaktadir.]

Font Browser: Oak-System [http://www.oak-sys-
tems.co.uk/oak/fontbrowser.html] tarafindan gelis-
tirilmis bir font y6neticisidir.

[Sadece Windows siiriimii bulunmaktadir.]

MainType: High-Logic [http://www.high-logic.
com/maintype.html] tarafindan gelistirilmis bir
font yoneticisidir.

[Sadece Windows siiriimii bulunmaktadir.]

Fontlarimiza Tiirk¢e Ogretelim

Fontlarimizin Tirkge bilmemesi bizi bir ¢ok prog-
ramda zor duruma sokmugtur hep. Serde grafiker-
lik oldugundan, acil durumlarda §’lerin gengelini,
G’lerin sapkasini, I’lerin noktasini manuel olarak
ayarlayp idare ederdik. Uzun soluklu bir kullanim
i¢in gerekliyse fontumuz, Fontographer denen font
cambazi ile bohgasini agip Tiirkge karakterleri yer-
lestirerek fontlarimiza Tiirkge konusmayr 6greti-
yorduk. Derken gegtik OS X denen Unix platformu-
na. Programlarimiz ayni programlar, fontlarimiz
da ayni fontlar olmasina ragmen Unicode denen
bir yerlesim diizeni yiiziinden bir anda Tirk¢e’yi
konusamaz duruma geldiler. Daha dogrusu eskiden

tarzanca konugtuklarindan simdi Tiirkge’yi diizgiin
6grenmeleri gerekiyor. Unicode kabaca, tiim diller-
deki karakterlere bir kod numarasi verip hepsini tek
bir fontun icinde adreslemek olarak 6zetlenebilir.

Uluslararasi standart olarak Unicode belirlendikten
sonra programlar da teker teker Unicode destegi
vermeye basladilar. Bu da bizim Carbon yerlesime
gore Tiirkgelestirdigimiz fontlarin bu uygulama-
larda Tirk¢e konusamayacagi anlamina geliyor-
du. Fontlarimizi bu sefer Unicode yerlesime gore
elden gegirip Tirkge karakterleri olmasi gereken
asil hiicrelerine almamiz demek. Asil hiicreler diyo-
rum ¢iinkii Carbon uygulamalarda ¢aligtirmak igin
mincikladigimiz fontlarda Tiirkge karakterleri ilgili
harfe klavyede bastigimizda gittigi hiicreye koyarak
yapiyorduk. Yani Fontographer’da $’ye bastigimiz-
da segili hale gelen fi hiicresine “$”, fl hiicresine “s”,
Euro hiicresine “g” koyarak diiz mantikla fontla-
rimiz1 Tirkge’lestirmis gibi yapiyorduk. Unicode
yerlesim diizeni “Her harf kendi hiicresine. Mars
mars!” diyerek bizim de bu basit diizenimizi bozdu.
Haliyle yeni diizene ayak uydurmayan tiim fontlar,
FreeHand gibi Carbon temelli programlarda vaziye-
ti idare ederken, Photoshop, Word, FinalCutPro gibi
Unicode tabanli programlarda bir anda yalin ayak,
¢iplak bag kaldilar. Sorunun kaynag: ifsa olduguna
gore simdi ¢oziimiine gegelim.

Esikden bir Fontographer vardi, ne oldu
ona?

Uzun siiredir yeni bir siirim ¢ikartmakta nazla-
nan Fontographern boslugunu FontLab isimli
uygulama kisa siirede doldurdu. Akabinde Font-
Lab Fontographer’s Macromedia’dan satin ald1. [O
zamanlar Adobe daha Macromedia’yr almamus.
Heeeey gidi giinler hey!] Hatta OS X siiriimiinii bile
¢ikard: gegenlerde fakat yetersiz CodePage destegi
sebebiyle bizim isimize yaramiyor.

FontLab’1 ve karakter tablosunu tanryalim
FontLab’da [Ttirkiye Distribtitérit MACROMhttp://
www.macrombilisim.net/] File meniisiinden New
komutu ile bos bir font tablosu agalim. Tablonun
tizerindeki meniilerden sag kisimdaki kiimede im-
leci tizerine getirdiginizde “Codepages” yazisi ¢1-
kan, sagdan tigiincii butona basiyoruz.
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“Mac OS Roman” yazili agilir meniiden “Mac OS
Turkish”i se¢iyoruz. Hemen solundaki “Unicode”
kismini da “Name”e getiriyoruz. “Unicode” hiicrele-
rin kodunu, “Name” ise hiicrelerin i¢inde bulunma-
s1 gereken karakterlerin ismini gosterir. Biz ismini



gorerek islem yapacagimiz i¢in burayr “Name”de
birakiyoruz. Diger karakterlerle birlikte Tiirkge ka-
rakterlerin de bulunmasi gereken hiicre diizeni bu-
dur. Diizenleyecegimiz fontlarda bu yerlesimi esas
alacagiz. Bu pencere simdilik kenarda dursun.

Unicode’alim

Simdi bir fontu adim adim Tiirkgelestirelim. Isleme
baslamadan o6nce 3 tiirli font Tiirkgelestirme oldu-
gunu hatirlamakta fayda var. Birincisi, el degmemis
ve S, G, I gibi sorunlu Tiirkge karakter bulundur-
mayip C, 0, U gibi karakterleri barindiran fontlar.
Bunlara “Cat Pat Tiirk¢e Konugan Fontlar” diyelim.
Ikincisi, G, O, U harflerini de icermeyen, tamamen
Tiirkge cahili fontlar. Bunlara da Tiirkge Bilmeyen
Fontlar diyelim. Ugiinciisii de, vakt-i zamaninda
el yordamiyla yanlig yunlus Tiirkge 6grettigimiz
ama zamana ayak uyduramayan fontlar. Bunlara da
Tiirk¢e’yi Unutmus Fontlar dersek sanirim basit bir
siiflandirma yapmis oluruz.

Bizim baslangi¢ noktamiz, “Cat Pat Tiirkge Konu-
san Fontlar” olacak. Yani C, O, U karakterlerine
sahip olup §, G, 1 karaterleri olmayan fontlar. $imdi
buraya 6nemli bir parantez agmam gerekiyor. As-
linda G, O, U karakterlerinin olup olmamasindan
ziyade, S, G, I harflerinin gentik, nokta ve sapkalari-
nin olup olmamasi daha 6nemli. Su ana kadar elden
gecirdigimiz binlerce fontluk tecriibeye dayanarak
G, O, U harflerini igeren fontlarda gentik, sapka ve
noktalarin da eksiksiz oldugunu gordiik. G, O, U
harfleri olmay1p bunlarin gentik ve noktalarini ba-
rindiran fontlar da bizim i¢in makbuldiir ve onlar1
da hi¢ cekinmeden Cat Pat Tiirk¢e Konusan Fontlar
sinifina sokabiliriz. Yani 6nemli olan, ¢entik, sapka
ve noktalar.

Peki gentik, sapka ve noktalara sahip oldugumuzu
nasil anlayacagiz? Her hiicrenin bir ismi ve kodu
oldugunu séylemistik. Kenarda agik tuttugumuz

bos font tablosuna bakarak hiicrelerin isimlerini
inceleyebilirsiniz. “$” ve “C” harflerinin imalatin-
da kullanilan ¢entiklerin yuvalandig: hiicrenin ad1
“cedilla”dir. Sondan dérdiincii hiicreye bakarak
kendisini teshis edebilirsiniz. “I” harfinin ireti-
minde kullanacagimiz noktanin adi “dotaccent”
olup cedilla’dan iki hiicre solda ikamet eder. “G”
ve “g” harflerinin sapkasini da dotaccent’in hemen
solundaki “breve” hiicresinde bulabilirsiniz. “O” ve
“U” harflerinin noktalar1 da “dieresis” ismiyle TM
hiicresinin iki saginda gecekondusunu dikmis, mi-
safir kabul etmektedir.

Bizim baslangic noktamiz “Cat Pat Tiirkge Bilen
Fontlar’dir dedik. Sayet Tiirkge 6gretmek istedi-
gimiz font bu sinifa girmiyorsa, yani nokta, ¢engel
ve sapka hiicreleri bossa 6nce bunlar1 doldurmamiz
lazim. Bu islem igin grafik bilgisi, estetik duygusu
ve biraz da zaman lazim. Harfleri inceleyerek nasil
bir nokta ve ¢engel ihtiyaci olacagina karar verip bu
isaretleri gerekli hiicrelere yerlestirdigimizi varsa-
yiyorum. Isterseniz hiicreyi ¢ift tiklayip karsiniza
gelen tabloda, alet kutusundaki araglar yardimiyla
¢izin, isterseniz bagka harflerin uygun gérdigiintiz
sapkasini kopyalayip deforme ederek yapin, ister-
seniz bagka bir fonttan sapka araklayip uydurun,
isterseniz FreeHand, Illustrator, Corel gibi vektorel
tabanli grafik programlarinda cizip ithal edin, na-

s1l yaparsaniz yapin ama liitfen abuk subuk sapka
ve cengeller yapmayin. Hadi yaptiniz diyelim, liit-
fen bu fontu kimseyle paylagsmayin. Fontu mundar
ederseniz hakkimizi helal etmeyecegiz. $u memle-
kette en azindan fontlarimiz diizgiin olsun.

Sayet Tirkee’yi Unutmus Fontlar’dan biri ile kars:
karsiya isek [yani ge¢mis zamanda Tiirkgelestirdi-
gimiz ama Unicode uygulamalarda unutkan dav-
ranan] o fontu da Cat Pat Turkce Konugan Font
haline getirmemiz lazim. Breve, dotaccent, cedilla
hiicrelerinin dolu olduguna emin olduktan sonra
gorebildiginiz tim G, g, §, 5, I harflerini silerek bu
islemi gergeklestirebilirsiniz. Silme iglemini, ilgili
hiicreleri secip silme tusuna basarak ya da Edit me-
niisiinden “Delete” komutu vererek yapabilirsiniz.
Farenizin sag tusu ile, sag tus yoksa kntrl+tik ile de
“Delete” komutuna ulagabilirsiniz.

Bana Tiirk¢e Konusmak Isteyen Font Bulun!
Isimizin 6n hazirhgin yaptik. Simdi adim adim
font Tirkee’lestirelim. Bu islem i¢in sansh bir font
secelim. Programin i¢inden File > Open komutu
ile fontu acabilecegimiz gibi Finder’da iken fontu
tutup FontLab tizerine siiriikleyerek de agilmasini
saglayabiliriz. Sayet agmak istediginiz font bir font
bohgasi igerisindeyse size “Hangi stilini agayim?”



manasinda bir pencere ¢ikartir. Buradan istedigi-
niz fontu veya fontlari segerek agabilirsiniz.

Open Macintosh Suitcase

< [ Bell

BellGothicBTBlackTi
BellGothicBTBoldTi
BellGothicBTBoldElektitalicTi
BellGothicBTBlackElektitalicTi
BellCothicBTRomanTi
BellGothicBTElekitalicTi

I 5 5 B

" Open All )

( (_ Cancel ) (0] 4

Biz AntiqOlive fontunu agtik. Ve karsimizda kar-
man ¢orman bir tablo bulduk.
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Saga sola serpistirilmis ekser miktarda G, $ harf-
lerine bakarak bunun daha evvel Tiirkgelestirilmis
oldugunu anladik hemen. Yani fontumuz Tiirkgeyi
Unutmus Fontlar sinifina giriyor. Tiirkge karakter-
leri var ama Unicode uygulamalarda ¢alismiyor.
Once font gériintilleme diizeninin Codepages'te
olduguna emin olalim. Hiicrelerin kodunu de-
gil de ismini gérmek i¢in soldaki agilir meniiden
Name’i segelim. Hemen sagindaki meniiden Mac
OS Turkish’i de segtik mi ilk ayarlarimizi yaptik
demektir. Resimden de goreceginiz tizere gerekli
gereksiz bir ¢ok hiicreye Tiirkge karakter serpistiril-
mis vaziyette. O, U, G ve bunlarin kiigiik harflerinin
dogru hiicrelerinde oldugunu griiyoruz ama G, §,

U
o

i o

«»

1, S, s harfleri yerlerinde degil. “1” harfi ise “dotlessi”
hiicresinde, yani yerinde. Breve, cedilla, dotaccent
hiicrelerinde de sapka, ¢engel ve noktanin mevcut
oldugunu gérdiigiimiize gore bulabildigimiz tiim G,
g5 s I harflerini siliyoruz. Elinizi korkak aligtir-
mayin, silin!

Eger Tiirkge karakterleri yerlestirecegimiz hiicreler
bos ve beyaz renkli ise sorun yok, hemen ise koyula-
biliriz. Eger beyez degil de gri renkte ve sanki Times
fontu ile yapilmig Tiirkge karakterler varmig gibi
goziikiiyorsa bu hiicreler kapali demektir. Once bu
hiicrelerin {izerine ¢ift tiklayarak hiicreleri agma-
lLisiniz. Bu hiicreleri agmadan Tiirkge karakterleri
tiretmeye kalkarsaniz karakterler tablonun en so-
nuna yuvalanacaklardur.

Simdi Glyph > Generate Glyphs meniisiinii galigtiri-
yoruz. Karsimiza hiicre ekleme penceresi geldi.

Generate Glyphs

Clyph names separated by space or comma

_ Decompose ligatures ) Mark new glyphs

™ Replace existing glyphs

N =)

_ Create glyphs even if they already exist

Yeni olugturmak istedigimiz harflerin isimlerini bu
pencereye aralarinda bosluk birakarak veya virgiil
koyarak yaziyoruz. G iin Gbreve; § igin gbreve;



§ i¢in Scedilla; § igin scedilla ve I i¢in Idotaccent
[yani Gbreve, gbreve, Scedilla, scedilla, Idotaccent].
Burada siranin, virgiilden sonra bosluk olup olma-
masinin bir 6nemi yok. Tiim karakterleri ayn1 anda
olusturmak zorunda da degilsiniz. Biz yazdik¢a
harfler tek tek beliriyor. “Replace existing glyphs”
kutucugunun isaretli oldugundan emin olup pence-
reyi onaylayabiliriz.
Cenerate Clyphs

Clyph names separated by space or comma:
Cbreve gbreve Scedilla scedilla Idotaccend

! Decompose ligatures __| Mark new glyphs

# Replace existing glyphs
4 (o) €96

O Glyph Properties

[ Create glyphs even if they already exist

Font: AntiqueOliveT Yeni direttigimiz harf-

lerin kendi hiicrelerine

= gitmis olmasi lazim.
L _? | Sayet gitmediyse sorun
v Replace existing glypns degil. Ornegin 1 harfi

oF (nasig— ) 1 - yerine gi'tm?kte r}azlar}—
makta. I hiicresine bir

: ] A kez tiklayip segiyoruz
K gl L2 ve Edit meniisiinden

i + iF

Properties komutu veri-
yoruz. Karsimiza hiicre
bilgilerini igeren mini
bir pencere ¢ikacak.

Apply ) )
— Name kismina hiicrerin

adin1 yaziyoruz [Ido-
taccent]. Uni kismina
kodunu girmek lazim
ki harf gitmesi gereken
yeregitsin.Idotaccent’in

== kodu 0130. Tabi onca
B Replace existing glyphs . :
hiicrenin kodlarini

of (Unassig.. 9 1 . esberlemek zor olaca-

e gindan Uni pencere-
84 315 sinin yanina isimden

& numaray1 tespit etmeyi
saglayan bir elmas ko-
nulmug. Hiicrenin adin1
yazdiktan sonra buna
basarak kod numara-
sinin  otomatik olarak

(8] Glyph Properties
Font: AntiqueOliveT
Wie  |dotaccent

U 0130 »

W+ B4

S N ]

Ll (84, 00 mn (231,992)

| - Classes.

Apply

¢ikmasini saglayabilirsiniz. Replace existing glyphs
kutucugu burada da segili olsun. Béylece gitmesi
gereken hiicre dolu bile olsa yerindeki harfi kovacak
ve kendisi yerlesecektir. Merak etmeyin, kovulan-
lar silinmeyip listenin sonuna gider. Sonra onlar:
isimleriyle tanimlay1p gitmesi gereken yere gonde-
rebilirsiniz. Son olarak en alttaki Apply butonuna
tiklayarak iglemi tamamliyoruz.

Bagka hiicrelerde gezinen tiim hiicreleri bu yontemle
olmalar1 gereken yerlerine gonderin. Sayet hiicreye
tikladiginiz halde properties paletinde isim ve kod
numarast pencereleri aktif olmuyorsa hiicreye ¢ift
tiklayarak agilmasini saglayin. Pencerelerin aktif
oldugunu goéreceksiniz. Genelde bu sorun, gereksiz
hiicrelerin silinmesinden sonra ortadan kalkar.

Gereksiz Hiicreleri Silin
_286 gibi ne idiigii belirsiz isimlere sahip bos hiic-
releri silin.

notdef

1

=]
ZCaron

overscore |increment

O ]
- —

iy
71~ Al
Sar1 baslikli hiicreler bittikten sonra baglayan gri
baslikli hiicrelere tiklayarak isim ve kod numarala-
rinin oldugundan emin olun. Kod numaralari yoksa
otomatik olarak tirettirin. Sar1 baslikli hiicrelerde de
anormallikler olabilir. Mesela NULL isimli hiicrenin
-null ismiyle en iistteki ilk hiicre olmasi lazim. On-
dan itibaren Space hiicresine kadar hig bir isaret ve
harfin olmamasi lazim. Sayet varsa, Properties’ten
kodunu trettirin ve Apply’i tiklayarak dogru yerle-
rine gitmesini saglayin. Thorn, Euro, fi, fl gibi hiic-
relere kesinlikle Tiirkge karakterler koymayin. Bii-
tin harf ve isaretler sadece kendi asli hiicrelerinde
bulunmali. Fontumuzun tablo yerlesimi hazir.

Ayarlara gegmeden evvel yapmamiz gereken 6nemli
bir islem daha var. Yeni tirettigimiz harflerin gorii-
niigiiniin diizgiin oldugundan emin olmak igin tek
tek kontrol edecegiz. G harfini ift tikliyoruz. Kar-
sumiza ¢ikan tabloda sapkanin yerinin dogru olup
olmadigina bakiyoruz. Ozellikle italik karakterler-
de sapka, ¢engel ve noktalarin dogru yere tesadiif et-
mesi biraz sans isi oldugundan bu ayarlama mutlaka
gerekiyor.

I’nin noktast ile § ve s harflerinin ¢engellerini de



ayarladiktan sonra 6zellikle § ve § harflerinin ¢en-
gelleri ile govdelerinin kesisim noktasinin baskilar-
da beyaz ¢itkmamasi i¢in bir ayar daha yapmamiz
gerekiyor. Her iki harfi de se¢ip Glyph > Decompose
komutunu veriyoruz.

H l. Tocls Window

Reset

Export to EPS...

Choose Glyph... ®a
Rename Glyph... )\

Generate Glyphs... #G
Clyph Names »

Harflerin segilmisliklerini gidermeden Tools >
Outline > Merge Contours komutu veriyoruz. Béy-
lece gengeller govdeyle birlesip yekviicut oldu.

Tools LG
H Mirror
Hints & Guides > | v Mirror
Templates >
Operations »  Check Connections
= Reverse All Contours
Multiple Master > Nodes at Extremes
Assign Mask... Snap to Guides £ F9
Kerning Assistance... Optimize #E
Metrics Assistance... Expand S‘"’"”I’

Transform... BT n Al

Transform Range... OXT
glend Fonts Merge Contours ® ...
Cet Intersection

External Tools > Delete Intersection

Customize... To TrueType Curves {32
M To Type 1 Curves
C ve ¢ harfleri daha evvel olusturulmus olsalar bile
gengeller govdelere kaynastirilmamis olabilir. Bu
harfleri de kontrol edin ve gerekiyorsa ayni birles-
tirme iglemini her ikisi i¢in de yapin. $imdi ayarla-
rimiza gegelim.

: Fontumuzun {iist menii-
b siinde “Name”in hemen
1 solundaki “Font Info” bu-
tonuna basarak ya da File
> Font Info meniisiinden
1 . ayarlarimizi yapacagimiz
' ' béliime ulasiyoruz.

Simdi buradaki ayarlara
I T tek tek bakalim.

Foat Inko - AnticrseCares{T]

Basic ot of font names

[ R re—— ]

b s g Sermngs = =
Type 1-spaci seinge waigh; [Formal B T Crosein e

| [ ruetipe-soucec sisegs e T @ Cremnio

| Mors Sryles v

| Soyin Nama: [Paguer Bl Srvie Wame

Fort Mamg: [AntryoeOireal
o8 Name: [RrirorGirmeT]

Marve K. [ g eGiremiT]

FOND Namg: At weCleeelT]
# Buld e

(Carcet | (Apor ) (0N

Names and Copyright: Fontun ismi ve stili zaten
varsa sadece en alttaki “Build Names” elmasina
tiklayarak saglamasini yapiyoruz. Names and Cop-
yright meniisiiniin bagindaki tiggene tiklayarak alt
meniilerin ¢tkmasini sagliyoruz.

i Fiae ik = AntiquetOive{T]

Banic vat of fomt maman

[+
|+

Famity Nama: At queDionT]

[revrueer Wesghe Tiomal B 905 Dlrose i nase
taue infermaticn Font i baid
et
 ¥urion and emmteanin e L]
b Metset and Dimmsiens —

Srvia Namar Fgiar B Sryte Name
Troe L-apecic settings

b TraType-spacic smnge
Fors oo

oot Nama: AabquelivelT]
Full Mame: AsoqueDiondT]
Masu Nams ARD Qe el .
FOND Name:  AabquedioT]

¥ 8258 Kamey

(Cancel ) (_Apoy ) (NS

Burada 6nemli bir konu ile kars1 karsiyayiz.
Font isimleri!!!

Fontlarin isimlerini kesinlikle degistirmeyin. [En
biiyiik font Gireticisi olan Adobe’nin fonlt listesinden
elinizdeki fontlarin isimlerin ne olmasi gerektigini
http://store.adobe.com/type/pdfs/Typel-2-OpenT-
ype.pdf adresinden indirebileceginiz belgeden bu-
labilirsiniz.] Oniine sonuna herhangi bir ek koyma-
yin. Font karmagasinin 6nemli sebeplerinden birisi
de budur. Bu ¢aligma igin 6rnek olarak agtigimiz
fontumuzda da benzer bir durum s6z konusu. An-
tiqueOlive isminin sonuna bir [T] eklenmis. Bu [T]
yi kaldirip font ismini orjinal haline déniistiiriiyo-
ruz. Daha sonra “Build Names” butonuna tiklaya-
rak fontun diizgiin isminin olusmasini sagliyoruz.



Fam nfo - AntigueCieelT]

Basie 520 of fiot mames

I+
[+

[T

—
Dessgoes infoumation (R M
Whddh: e

More Stvien

Sty Wa Faguias i Sovle Name |
fot Masra: Ares]ling
Full Mams. Aoy

Suasdard sema (TL Mavngh Man Mama: Arteguie *

Adgrioaal Misting paramasers —
Trpe L-pacils pemngs FOMD Wame:  Arcaqoading
- TroaTrae-saecilc g
sk Names.
Dreica matrien

Booly and charge foet: (¢ ¢ [ H ¢ [ Coov ) Cancel ) (_acol | (GRS

OpenType-specific names: “Build OpenType Na-
mes” elmasin1 tiklaylp otomatik isim vermesini

sagliyoruz.

Font infs - ArtqueOinaiT]

DpenType-sawcilic fom ramss a0
Farmity Namg: AtEqueOiom

Saye Narer Figudar

Mac Name: Asbquedioe

#Be%d OpenTypt Mame || X gt Names

Comy.. | Carced ) (_Apsy ) (R

Additional OpenType names: Kirmizi garpi isare-
tini tiklayarak yazili ne varsa siliyoruz. “Platform”
meniisiinii “0 Unicode” yapiyoruz. Metrics and
Dimensions’a kadar her hangi bir ayar yapmamiza
gerek yok.

Font lnko - AstigseCaree(T]

v . Toarma] table *

DoenTya-ineohe simes B
CoenTrps sames = [+T=1[%
Coere g o atn
imnenag wolFo o[ [T
Desigrar intormanan CRCICN m ﬂ
afpmation 10 0 0 AsewOiv]

w Vernian sed Iduns ication 200 0 Repw
oy identification settiagh 10 0 0 Miacromansa Faengrasher 41,5 AmaueCinalT] <
Fantas dasthesten 400 0 MengeieeT] (2
B4 4o US. et Feation

LTy — u 0]
G dimeniars Puttoom Eacofieg Lampuage:

Susscnt and Supamerzt Qlnesde T80 (A0 L]

Standars staem (11 hinteg)
Addnneal batag parETEE ©
Trot 1-taweifs serina H

(Carel ) [ Rewh | (S

Faest info - AntigueCiee]T]
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ET=

W00 (GO0 [ Test

v Namas an oyt | Nan- Englinh or spasial fomt mames: [namal tabls

2ampen e
TraeTrae-saeciic marics r ~
s ot s Bepariart oimeste T8 ® L]

Trot 1-apecic semns

Metrics and Dimensions: Eger bir OpenType font
olugturmak istiyorsaniz “Font’s UPM is:” kismin-
daki rakam 1000’den ufak olmamali. 1000’den ufak
ise 1000 yapryoruz “Scale all glyphs according to
UPM change” kutucugunu isaretliyoruz. Rakam
1000’den biiyiikse veya TrueType font iireteceksek
karigmiyoruz.

& Fomt ink — AnbigaCoba{T]

1
B Varsien aed idnet feation
= Metries and D
ey dimensacs
TraaTye- b0 i matrcs
Seliscrins and Superscrine
B frcoding and Unicods
B inting Suttingy
Troe -towcilic sactingy
B TrasType-spechic uttings
Tent scm
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Fonrs U s 1334
 Seale 4l giyps accsrdiog e UPM chasge

{ Carend sy | ()

Key dimensions: “Recalculate” elmasina tiklayip
otomatik ayar yapmasini sagliyoruz.

Faest il - AntigueCiee]T]

% Nawes s Comright toat bt ot oo .l
b Weriion and et fianon
> Macics and Dimansizms
for the master-
TranTysa-ssecifc mrcs - - =
ot il Somivitit Masender. EE Descender: 10 _# Recuiculute
¥ Incedirg and Unicade
I+ bliag Samags Caps haight 841 gk
ot L-dpecific settngs — Couy values 10 TreaType matrics.
b TrueTyoe-wsecide semagi
Fort pote Ralc angle: @ St angle: T
B Syrchrosias St and habi anghes
Underbng: -125 Thichneis: 50
— Feat i monsapaced
R ——
Font Blou (54, -2130 - (1104, 10961
Curcel ) (_Meow ) (N

TrueType-specific metrics: Her iki “Recalculate” el-
masina tiklayarak otomatik ayar yaptiriyoruz.

Font Ink - AsbgeelivelT]

b Mames and Cosyright

| Additional vartical matrica (s Type-specifics [+]
b Weroe and lgesn ot on

= Wi and Cimenaions =
ey skirumy ZiCaicutane walees suromatically [rscsmmandedt
Bt coatom
Bebiarat and Buparririgt =
¥ [ncoding dad Usicode 108721 TrooAscender 78
b Hitag ettisgs TrocDescender: 178
Trow L-igeali intEngt
b TronTios-sgweific 14sags TomelineCap: 8

Pockbiee WeAscans W

WirDescuns. -1

Strkeout sestion. 354 Surikesnt vckness: 57

# rcacune
Average wedth. © s

L T8 o o s ot BSREE

Subscript and Superscript: Herhangi bir ayar yap-
maya gerek yok.

Encoding and Unicode: Sagdaki “Supported code-
pages” kisminda herhangi bir dil kodu varsa kirmi-
z1 butona basarak temizliyoruz. Sonra alttaki yesil
elmasa basarak otomatik olarak dillerin gelmesini



sagliyoruz. Yalniz burada bize lazim toplam 4 dil
kodu var: 1250 Latin 2: Eastern Europe, 1252 Latin
1, 1254 Turkish, Macintosh Character Set [US Ro-
man]. Bunlardan eksik olan varsa soldaki listeden
bulup saga bakan mavi ok ile sag listeye ekliyoruz.
Sag listede, bu dort dilden bagka diller varsa onlara
karigmryoruz. Son olarak alttaki “Microsoft Cha-
racter Set” acilir meniisiinden “Turkish [Latin 5]
CP125471i segiyoruz. Buradaki ayarlar bu kadar.

Faes info - AntigueCiee]T]

¥ Names ared Coupright Supported codepages and defualt charactar set .
b Version and kentifanon
[ — R - o
¥ Encedling mnd Unicads BT Tarkish o | [ i i
inicids sbnges FS5 WM Cynile; promarityRagt| | — | 1754 Tusk
My Wit o |Hacincash Cramcher Sen s om
Trpe 1-1peciic sattings fuiic B [0 i e Euee
b TrunTysa-ssacihe gt amas 457 G x
Foet nese abc; AT 708 =
Betereed b 03
Futereed b 10 .

Craracuar Sas infuomanon

Mrosaft CharictasSat | Turkan s 5 CPAT54 ]

F Dfauk characnar

Ma porigt and FOND I3 | Aoman = B
Care ) Mooy ) (0N

Unicode Ranges: Once kirmizi butona basarak te-
mizliyoruz sonra yesil elmasa tikliyoruz. Bagka bir
sey yapmaya gerek yok.

Fam info - AntiaueCiee[T]

¥ Kamer [+
B Variion and identricaton T
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Aradaki kisimlarda herhangi bir degisiklik yapma-
yacagimiz i¢in atliyoruz.

TrueType-specific settings: “Use default export op-
tions” kutucugundaki onay isaretini kaldiriyoruz.
En alttaki agilir meniiden MacOS Turkish’i segi-
yoruz Preferences’'tan daha evvel bu ayar1 MacOS
Turkish’e getirirseniz, onay isaretini kaldirdiginiz-
da MacOS Turkish otomatik olarak gelir ve listeden
se¢gme zahmetinden kurtarir. Bagka bir ayar degi-
sikligi yok.
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Aradaki tiim kisimlar: atlayip PCLT table altindaki
Font metrics kismina geliyoruz.

Font metrics: Width Type kisminin altinda kalan
“Recalculate” elmasina tiklayip otomatik ayar yap-
tirtyoruz. Ustteki elmasa dokunmuyoruz. [Resim].

Foat Infa - Anbgeive(T]

¥ Namas and Commght IPELT] metrics ase fomt description +lf+
b ¥aruon ang gt st on Ld|Ld
¥ Mot and Domemicms =
} Lacedieg wiath: | Normat ]
o Fostere: | Uright Bl
Trpe S-agmcili settings
 TrueTyse-spacifc semings Structors; | S erma, bk ™
5 -
Dt metrcs SrrokeWrght. |0 Boo, tm, regelar, ot 1]
Fors ymsathing ; === — o
Fonn fags: [head] table i S ]
s * Sams Savil/Miortng ) San Contranting
Fans dencfcasion
Foet matrics s Type: | © Normat W
Codesagen
P nane Puch: SIE
Heght T Capsieight B41 * tecwcutre

Cancel | (_Asoiv | 0N

Codepages: Recalculate.

o info - AntiaseCien(T]

B Mamas and Coprright [PELT] supparind eodapages

Tyosfuce: Mataeedve

Fie name: AOTHDD

Character $a

Undrbond ]

Faet smesthing Craractar Comghmant. SOROD0ON0II0N
Faet fags: (ead] tabie

v PO bk

mitcaon

ey

Form note

Caneal | Asphy

o

Ayarlar bu kadar. OK butonuna basip islemi bitiri-
yoruz. Geldik son adima. Artik fontumuzu Genera-
te edip giile giile kullanabiliriz.



Generate Hele Siikiir

Fontunuzun tiim ayarlamalarini yaptiniz. Genera-
teislemini yapmadan 6nce ¢aligmanizi FontLab’in
kendi formatinda kaydetmenizi tavsiye ederiz. Di-
lerseniz “Preferences” bolimiinden otomatik kay-
detmeyi de aktiflestirebilirsiniz. Bazan FontLab
beklenmedik bir sekilde Generate islemi esnasinda
kapanabiliyor. Bu sekilde bir yedek almak tiim ¢a-
lismay1 tekrar yapmamaniz igin faydali olacaktir.

File>Generate Font komutunu verince karsimiza
fontun tiiriini belirlememiz i¢in bir pencere ¢ikar.
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Buradan PC TrueType’ segip fontun isminin diiz-
giin olup olmadigini kontrol ederek “Save” diyoruz.
Eger 6rnekteki font isminin sonundaki “T” gibi font

adinda bir fazlalik varsa bunu siliyoruz.

ne Generate Font
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Urettigimiz bu font Mac OS X ve Windows ayirdet-
meksizin Carbon veya Unicode tiim programlarda

diizgiin caligacaktir. Test igin FreeHand’de 1GgSs
yazip convert edin. Photoshop, Illustrator, Word ve
Quark programlarinda yazin. Herhangi bir sorun
¢ikmadigini kendiniz de miisahade edin.

Neden TrueType yapiyoruz??

Evet TrueType yapiyoruz fakat bu yaptigimiz fant da
OpenType. Eger OpenType fontlar PostScript hat-
lar1 kullaniyorlarsa fontun uzantisi .otf, TrueType
hatlar1 kullaniyorlarsa .ttf’dir. Sonugta yaptigimiz
font TrueType hatlar1 kullanan OpenType bir font.
Bunu tercih ediyoruz ¢iinkii garip bir sekilde .otf
uzantili fontlar FH’de ekran gériintiilemesinde so-
run ¢ikartryor. Mesela GS yazdiniz ama alakasiz ge-
killer gikt1. Yaziya biiyiitegle yaklasinca ya da bel-
li bir buyiikliikte yazdiginizda bir bakiyorsunuz ki
font diizgiin. Diizgiin goziiken fontu “Convert” edi-
yorsunuz, bir bakiyorsunuz ki Tiirk¢e karakterler
yerine kutucuklar gelmis.

Fontun Unicode olmasi i¢in OpenType olma-
s1 gerekmiyor mu?

Birbirine en ¢ok karistirilan iki kavram bu. Uni-
code, her bir karakterin bir numara ile belirlen-
digi bir sistemdir. Bu sisteme uyduktan sonra fon-
tun TrueType, PostScript ya da OpenType yapmak
arasinda bir fark yok. OpenType PostScript ya da
TrueType hatlara sahip olabilir. OpenType’in avan-
tajl, birden fazla dile ait 65.000’in Gizerinde karakter
hiicresini kodlayip calistirabilme becerisinde ya-
tiyor. Sayet bir fontun igerisinde hem Rus¢a, hem
Arapga, hem Latin karakterleri barindirmayacak-
saniz OpenType yapmanizin da anlami yok. Bu ka-
rakterler zaten fontun igerisindeyse zaten $G harf-
lerimiz de yerli yerindedir.

Fontu Generate ederken program kapaniyor
FontLab ile ¢aligirken sistem dil tercihlerinizin
English’de olmasi yararinizadir. Bu hem uygulama-
nin diizgiin ¢alismasini saglar hem de kisa yollar1
kullanmaniza izin verir. Ayrica fontunuz arizali ya
da korumali olabilir. Bu durumda FontLab’da yepis-
yeni bir font tablosu agiyoruz. Dolu hiicreleri kopya-
lay1p ayni hiicrelerine yapistirtyoruz. Shift ile birden
fazla hiicre segerken arada bos hiicreler olmamasina
dikkat edin yoksa bostan sonraya gelen hiicrelerin
hepsi kayiyor. Bos hiicre ile diger bos hiicre arasini
secip kopyalayarak yeni agtigimiz tablodaki yerleri-
ne yapistirdiktan sonra bos olani atlayip ayni islemi
devam ettirmek gerekiyor. Kopyalama isi bitince,
orjinal fonttaki isim, stil, ID numarasi, PANOSE
numarasi bagta olmak tizere biitiin ayarlar1 aynen
aktarip yukaridaki iglemleri de tek tek yapiyoruz.
Simdi sorun ¢itkmayacaktir.
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Hersey giizel de PC’lerde sorun var!

Bu yontemle yapilan fontlart hem PC hem Mac plat-
formunda, FreeHand, Photoshop, Word, InDesign
tizerinde denedik ve sorunsuz ¢aligtigini gordiik.
Buna ragmen bazen FreeHand ve Photoshop’ta
diizgiin ¢aligmadiklarina dair duyumlar aldik. Sa-
yet boyle bir sey basiniza geliyorsa buyrun ¢oziimii.
Bu bizim hatamiz degil. Once bunda anlagalim.
Dogru soyleyin siz zaten PC platformunda bir ¢ok
fontu FreeHand ve Photoshop’ta diizgiin kullana-
miyordunuz. Ama sorun degil, buna da bir ¢6ziimii-
miiz mevcut Allah’a ¢ok siikiir.

Bu sorun sistemdeki ayni1 isimli eski fontu iptal edip
yeni fontu koyduktan sonra bilgisayar1 yeniden
baslatarak ¢oziilebiliyor cogunlukla. Sayet bu yon-
tem ise yaramazsa Start [Baslat] meniisiinden Run
[Calistir] bolimiine gelin. A¢ilan pencereye regedit
yazin ve onaylayin. Karsiniza Registry Editor [Kayit
Defteri Diizenleyicisi] agilacaktir. Bu pencerenin
sol kismindan Computer>HKEY_LOCAL_MACH
INE>SYSTEM>CurrentControlSet>Control>Nls>-
CodePage bolimiine ulagin. CodePage secildiginde
pencerenin sag tarafinda ab ikonlu 10000, 10001,
10002 gibi rakamlarla baslayan bir liste olusacaktir.
Bu listeden 1252’yi bulun. Sag tiklayarak Change
[Degistir] komutu verin. A¢ilan pencerenin deger
girilebilen béliimiinde c¢_1252.nls yaziyordur. Bunu

c_1254.nls olarak degistirin. Pencereyi onaylayin.
Bilgisayarinizi yeniden baslatin. Artik tim uygula-
malarda Tiirkge karakterleri kullanabilirsiniz.

Bitti mi?

Bitti. Herkese kolay gelsin. Yaptigimiz testlerde
gordik ki 6nerdigimiz yontem sonucu iiretilen PC
TrueType fontlar gerek MacOS X, gerek Windows
platformlarindaki tiim uygulamalarda sorunsuz ¢a-
lismaktadir. Her ne kadar ince eleyip sik dokumusg
olsak da bizim rastlamadigimiz, ya da goziimiiz-
den ka¢mis olan problemlerle karsilagabilirsiniz.
Maalesef bu konuda bir garanti veremiyoruz fakat,
sorulariniz ve sorunlariniz i¢in ¢ekinmeden mail
atabilirsiniz.

Ahmet Karakurt [yapmak@mac.com]

Hayati Sentiirk [hayatisenturk@gmail.com]

Kazim Tagkin [kazimtaskin@gmail.com]

Tesekkiir

Karsilagtigimiz problemlerin ¢oziimiinde bizden
yardimlarini esirgemeyen, Apple IMC Proje Midii-
rit Sayin Selguk Halicr'ya, ingilizce dokiimanlarin
cevirisindeki emegi sebebiyle Bilkom Adobe Uriin
Sorumlusu Cagdas Sevgen’e tesekkiir ederiz.
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